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PLOT i MJERILO u AutCAD-u 2007 
Kao što i sami znate svaki program ( dobro, dobro  skoro svaki ) može imati funkciju ( naredbu ) za 
ispis vašeg rada ( PRINT ).  

U Autocadu se ispis naziva PLOT. Dakle kada završite crtež možete ga isprintati ( isplotati ) na pisač 
( PLOTER ) ili neki virtualni printer u obliku formata ( JPG, PNG itd.. ).  

Pripreme za PLOT-anje crteža su slijedeće:  

- Izrađen crtež 
- Instaliran pisač ( ploter ) ili virtualni pisač ( printer )  

Gotov crtež ( ili dio crteža ) možete PLOTATI na nekoliko načina.  

- iz MODEL-a ( odabrani pogled ) 
- iz LAYOUTA ( odabrani pogled )  

U koliko Plotate ( ispisujete )  neki crtež za koji je potrebno imati SASTAVNICU to možete na dva 
načina.  
Za detalje pogledajte link Sastavnica  

Za samu početnu radnju ispisa crteža na papir A4 ili A3 ili neki drugi FORMAT PAPIRA uz preduvjete 
koji su navedeni na početku potrebno se pozicionirati u MODEL ili LAYOUT ( ovisno što želite 
isprintati ) 
Nakon pozicioniranja u jedan od navedenih režima rada potrebno je pokrenuti naredbu File => Page 
Setup Manager a shodno pozicioniranju imamo jedan od slijedećih dijalog prozora. Prvi je režim rada 
MODEL a drugi režim rada LAYOUT1. 
Potrebno je kliknuti na gumb MODIFY...  
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Nakon klika na gumb Modify.. pojavljuje Vam se jedan od dijalog prozora  

Za MODEL i LAYOUT vrijede slijedeće potrebe postavki  
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Definicija CTB datoteke je prethodno postavljena datoteka sa postavkama debljine linije i ostalih 
elemenata na crtežu koji se nalazi na papiru. ( ovo se dosta koristi u Geodeziji ). Uočite ostale 
postavke koje su bitne za pripremu poltanja na papir. 
Također uočite da možete centrirati crtež prilikom plotanja kao i to da ga možete pomjerati na 
papiru po osi X i Y. Nakon postavljanja postavki kliknite na gumb PREVIEW da vidite kako će to 
izgledati na papiru. Nakon toga kliknite na DTM => Exit => OK => CLOSE.  

Sada imate postavljene postavke za printanje crteža.  

PRINTANJE iz režima rada MODEL  

Uzmimo za primjer da imamo ovakav crtež kao na slici dolje ( režim rada je MODEL a pogled je 
Conceptual Visual Style. i mi želimo isplotati samo dio crteža ( recimo lijevi toranj ).  

 

Nalazimo se u režimu rada MODEL. Prethodno smo postavili postavke položaja papira itd... a sada 
kliknimo na naredbu FILE => PLOT a potom u području "Plota Area" izaberimo sa padajućeg 
izbornika "Window". Sada nam se u prvom planu pojavio crtež a pokazivač miša je oblika bijelog 
križića. Selektirajmo dio crteža.  
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Nakon završnog klika na selektirano područje pojavljuje nam se dijalog prozor Plot-Setupa. Kliknite 
na gumb PREVIEW i pojavit će Vam se izgled crteža na papiru kakav ste selektirali.  

 

Jednostavno kliknite DTM ( desnom tipkom miša ) na crtež i na naredbu PLOT. Isprintat će Vam se 
crtež kakav vidite na papiru u Preview pogledu. Uočite da je ovo postupak u režimu rada MODEL.  
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Dakle kada imate neki veliki crtež ( površinski ) a želite samo dio crteža isprintati ( ZOOM crteža 
ovisi kakav želite )  tada možete koristiti ovaj način PLOTANJA iz režima rada MODEL ( često se 
koristi u Geodeziji bez LISP-a ). Ovdje je nebitno mjerilo.  

PRINTANJE iz režima rada LAYOUT  

U koliko želite printati iz režima rada LAYOUT imate također dvije mogućnosti.  

Prva mogućnost je :  

Prebacivanje u režim rada LAYOUT ( 1 ili 2 itd.. ) 
Nakon toga odmah Vam se pojavljuje dijalog prozor za PLOT-SETUP. Postavke postavite kako želite 
a postavku za "Plot Area" postavite na LAYOUT. Kada kliknete na gumb Preview pojavit će Vam se 
prazan papir ali nakon zatvaranja istog vraća te se u Layout i uočite Vaš crtež na papiru.  

Ovdje obratite pažnju koji Layer vam je "Set Current" ( trenutno aktivan ) tj. njegova boja. Iste boje 
će Vam biti i okvir crteža ( MODEL ) u kojem možete mijenjati zoom, položaj itd... crteža.  

Dakle ako u statusnoj alatnoj traci klikom na gumb PAPER ili MODEL mijenjate aktivnost tako ćete 
moći i manipulirati crtežom.  
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Kada Vam je aktivan PAPER tada možete zumirati kompletan papir sa svim okvirima i eventualno 
dodatnim elementima koji imaju Atribute ( ako ih ima izvan okvira crteža. npr: ako imate neki LISP 
u kojem se nalaze nekakvi elementi sastavnice ili npr: predloška katastarskog plana u geodeziji ).  

Kada Vam je aktivan MODEL tada možete manipulirati crtežom unutar okvira u kojem se nalazi 
crtež ( dakle zumirati, rotirati, itd... )  

Druga mogućnost je :  

Ako niste zadovoljni sa prvom mogućnosti tada možete na PAPIR postaviti nekoliko pogleda na crtež 
( VIEWPORTS ). Da bi ste imali npr,: ovakav ispis crteža. Uočite da je kompletan Layout prikazan u 
režimu rada MODEL a trenutno aktivni prozor modela ( okvir zasebnog crteža ) je okomiti zadebljan 
okvirom debele linije.  

 

Za takvu radnju potrebno je postupiti kao u opisanim koracima na linku ""sastavnica". Ovdje je 
opisan Insert BLOCK-a za printanje ali na isti način možete odrediti više pogleda na crtež za 
Plotanje.  

AutoCAD - export crteža u JPG sliku  
 
Izradili ste crtež u AutoCAD-u i želite ga poslati prijatelju ali kao sliku JPG ili PNG ili pak umetnuti u 
Word ili Excel dokument.  
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Pratite navedene korake kako se to radi:  
 
1. Ovo je naš crtež.  
 

 
 
2. Na tekstualnom izborniku kliknite na File => Plot ( ili CTRL+P )  
 

 
 

3. Potom izaberite za Printer/plotter "PublishToWebJPG.pc3" ili PNG opciju.  
Uključite opciju "Center the Plot"  
Kasnije ćemo odabrati veličinu papira.  
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Ukoliko nemate izbor za "PublishToWebJPG.pc3" tada idite na Tools => Options => Plot and publish 
=> pa isključite opciju "Hide system printers"  
 

 
 

4. Nakon odabiranja opcije pojavit će Vam se ovakav prozor ( ili sličan ) 
Odaberite gornju opciju za manju sliku ( ili ako želite veću rezoluciju tada izaberite donju opciju )  
 

 
 

5. Idemo sada odabrati veličinu ( rezoluciju ) po želji.  
Ja sam odabrao kao na slici da mi stane na papir word dokumenta  
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6. Čekirajte "Center thr Plot" i kliknite na OK gumb.  
Sada imamo JPG sliku kao ova ispod ( koju insertiramo u Word ili pošaljemo kao attach e-mailom )  
 

 

Ako Vam nije baš najjasnije pogledajte link http://www.ic.ims.hr/autocad/sastavnica.html ili skinite-
download OVAJ VIDEO *.avi ( 8 MB ) 
Raspakirajte ovaj ZIP file i pokrenite ga. U ovom videu možete vidjeti kako se nacrtana sastavnica 
može kopirati iz MODEL-a u LAYOUT a također kako se dodaje VIEWPORTS, kao i prijelaz u LAYOUT-
u iz moda MODELA u PAPER i obrnuto.  

Uživajte u plotanju ;-)  

 

MJERILO ( SCALE ) U AUTOCADU  
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NAPOMENA ! U Autocadu crtaju se veličine u stvarnosti ( prave vrijednosti dužina ) a crtež se 
ispisuje u mjerilu ispisa.  

Dugo sam se pripremao za ovaj dio web Autocad tutoriala i pitao se kako objasniti početniku pojam 
MJERILA i rada sa istim u Autocadu. Prosurfao sam dosta internetom i pregledao neku literaturu ali 
svatko to objašnjava na svoj način i dosta različito. U principu čak kod nekih pojašnjenja ( zbog 
kratkoće teksta ) bilo mi je teško sebi dočarati kako to funkcionira na objašnjeni način.  

Stoga ću ja pokušati od svega viđenog pronaći ono najpristupačnije početniku ( onako kako ja vidim 
mjerilo u autocadu ). Ako ste prošli ovaj web Autocad tutorial od početka link po link nadam se da 
Vam neće biti teško shvatiti ( ali ako niste onda ne znam ;-)  

Kao prvo u početku ovog web Autocad tutoriala napomenuo sam da prije samog crtanja potrebno je 
postaviti  - formirati određene jedinice ( UNITS )  

 

To je za početak crtanja dovoljno. Nadalje prilikom crtanja crtate sa vrijednošću jedinica. Dakle ako 
crtate u milimetrima tada će 1 mm također biti prilikom crtanja 1 jedinica, 1 cm bit će 1 jedinica ili 1 
m bit će 1 jedinica. A prilikom PLOTANJA ćete postaviti mjerilo da bi Vam crtež stao na papir.   

Dodavanje određenih mjerila u padajući izbornik radite pomoću naredbe SCALELISTEDIT u 
Command Proimpt Line.  
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MJERILO u LAYOUT-u  

Također možete koristiti alatnu traku ( toolbar ) VIEWPORTS  ( slika iznad ) u radu sa LAYOUT-om u 
MODELSPACE pa preko padajućeg izbornika birati mjerila za najbolji prikaz na papiru prilikom ispisa 
na printeru ( Ploteru )  

MJERILO U MODEL režimu rada ( MODELSPACE )  

Prikaz crteža prilikom crtanja možemo uvećavati i smanjivati pomoću točkića na mišu ( PAN ) ali i 
mjerila prilikom rada u MODEL-u ( MODELSPACE ) možemo podešavati preko određenih naredbi u 
Command Prompt Line. No opet to sve ovisi o postavkama. Ako ste crtali u milimetrima i odnos je 
bio 1 jedinica 1 mm tada će ove naredbe ispod vrijediti, no ako ste crtali u metrima stvarne veličine 
tada neće ove vrijednosti ispod biti valjane.  

U Strojarstvu se najčešće koriste slijedeća mjerila:  
za umanjenje => 1:2.5, 1:5, 1:10 itd...  ( 1 jedinica = 1 mm ) 
za za uvećanje => 2:1, 5:1, 10:1 itd... ( 1 jedinica = 1 mm )  
U Građevinarstvu se najčešće koriste slijedeća mjerila: 1:500, 1:100, 1:50 itd.. ( 1 jedinica = 1 cm ) 
U Geodeziji se najčešće koriste slijedeća mjerila: 1:1000, 1:1400, 1: 2000, 1:2500 1:5000 ( 1 
jedinica = 1 m )  

Za primjer pokazat ću ovaj crtež ispod. Prva slika je pogled na crtež 1:1 . Ali ako u Command 
Prompt line upišem slijedeću naredbu  

Command: Z [naredba za uvećanje - zoom ] 
ZOOM 
Specify corner of window, enter a scale factor (nX or nXP), or 
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: 1/1xp [ prikaz crteža u 
veličini prilikom crtanja crtanja]  
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Ako sada opet u Command Prompt Line upišem ovu naredbu  

Command: Z [naredba za uvećanje - zoom ] 
ZOOM 
Specify corner of window, enter a scale factor (nX or nXP), or 
[All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>: 1/2xp [ crtež se 
umanjio ]  
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Ako sada upišemo opet prvu naredbu crtež će se uvećati. Ovaj način uvećanja ( zumiranja ) se 
koristi u Geodeziji ( a s obzirom da nemam saznanja u drugim granama, ovdje ću prikazati mjerila 
za Geodeziju, sjetite se da su jedinice za Geodeziju METRI )  

Dakle kada PLOTATE crtež u Geodeziji imate nekakvu datoteku na kojoj je crtež neke Katastarske 
općine i ako ga želite plotati a slučajno ste u režimu rada LAYOUT => MODELSPACE točkićem 
pomjerili ( zumirali ) crtež pomoću ovi naredbi se možete vratiti na mjerilo koje Vam treba.  

1:500 => 2/1xp 
1:1000 => 1/1xp 
1:2000 => 1/2xp 
1:5000 => 1/5xp  

Za razliku od gore navedenih imate još mogućnosti pa ću ovdje dati samo primjere mjerila a Vi ih 
koristite tamo gdje Vam trebaju.  

1:250 => 4/1xp 
1:750 => 3/2xp 
1:1500 => 2/3xp 
1:2500 => 2/5xp  

S obzirom da decimalni broj u ovakvom načinu zumiranja tj. određivanja mjerila ne vrijedi evo jedan 
primjer kako odrediti mjerilo.  
 

1:2,5 => 10/25xp ( dakle pomaknimo zarez i imamo odnos brojki za mjerilo )  

Ako koristite Viewports toolbar tada i u njemu možete npr: napisati 1:5 => 0.2 
U tekstu iznad malo sam pojasnio kako se može odrediti mjerilo za pogled na crtež u MODEL-u.  
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MJERILO ISPISA  

MJERILO ISPISA uvijek treba odrediti ( dakle isplanirati ) prije početka crtanja jer ćemo se prema 
njemu ravnati kada budemo određivali veličinu teksta na crteži i ostalih elemenata kotiranja. No o 
tome kasnije na ovoj web stranici.  

Neka veličina crteža može biti na papiru uvećana ili umanjena ili u istoj veličini u kojoj smo crtali.  

Općenito možemo reći da je MJERILO omjer neke veličine nacrtane na papiru ( V na papiru ) i iste te 
veličine u stvarnosti ( V u stvarnosti )  

FORMULA ZA MJERILO  

Ako stvarnu veličinu crteža umanjujemo tada je odnos Mj<1. 
Mjerilo se prikazuje pomoću razlomka ( ili znaka za dijeljenje ) gdje je u brojniku broj 1 a u 
nazivniku faktor umanjenja M.  

FORMULA UMANJENJA  

Ako stvarnu veličinu crteža uvećavamo tada je odnos Mj>1. 
Mjerilo se prikazuje pomoću razlomka ( ili znaka za dijeljenje ) gdje je u brojniku faktor uvećanja N 
a u nazivniku broj 1. ( ovakva mjerila se često koriste u Strojarstvu za uvećanje )  

FORMULA UVEĆANJA  

Evo nekoliko primjera:  

Radimo sa milimetrima. Mjerilo 1:50 znači da veličina od 1 mm na papiru predočava 50 mm u 
stvarnosti ( ili 1m na papiru predočava 50 m u stvarnosti ) dakle umanjujemo crtež ovim mjerilom. 
Ako radite sa centimetrima i crtali ste  1:1 ( a tako bi trebalo i biti ) tada će mjerilo 1:10 biti 
slijedeće, 1 mm na papiru je 1 cm na crtežu ( 1cm=10mm )  

Prije samog crtanja trebamo odrediti ( isplanirati )  MJERILO. Zašto ?  

Zato što ćemo prilikom crtanja trebati kotirati, pisati nekakav tekst i sl. a tada će nam biti potrebne 
određene veličine teksta, kotnih strelica itd itd. A naravno moramo voditi i računa na kojoj veličini 
papira ćemo ispisati crtež.  

FORMATI PAPIRA:  
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- A0 => 841 x 1189 
- A1 => 594 x 841 
- A2 => 420 x 594 
- A3 => 297 x 420 
- A4 => 210 x 297  

PRIMJER:  

Evo razloga zašto nam je važno odrediti mjerilo prije samog ispisa.  
Uzmimo za primjer da trebamo nacrtati nekakav predmet širine 10 mm i visine 15 mm. S obzirom 
da je predmet mali mi ga moramo uvećati na papiru prilikom ispisa na A4 ( 210x297 ) a pri tome 
koristiti sastavnicu. Sastavnica nam je standardna i njen koristan prostor je po horizontali ( širini ) 
184 mm a po vertikali ( "visini" ) 285 mm ( ako radimo sastavnicu kao na prethodnom navedenom 
linku. ( morate voditi računa ako sastavnica ima tablicu pri dnu da i nju uračunate u koristan prostor 
tj. odbijete) što ja u ovom primjeru nisam jer nisam imao potrebu zbog veličine crteža.  

    

Prvo ćemo odrediti mjerilo za širinu ( pogledajte formulu za mjerilo iznad ). Koristan prostor po širini 
je 184 mm a naš crtež je u stvarnosti širok 10 mm  

 

zatim ćemo odrediti mjerilo za "visinu". Koristan prostor po "visini" je 285 mm a naš crtež je u 
stvarnosti visine 15 mm  
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Dakle ovim smo dobili dva rezultata ( mjerila ) koja možemo koristiti. Naravno uzet ćemo ono 
mjerilo koje je manje ( da bi crtež stao po širini ). Ovdje trebamo obratiti pažnju da uzmemo mjerilo 
koje ima cijeli broj a ne decimalu. Dakle slijedeće manje mjerilo od 18,4 => je 10  

U ovom slučaju naše mjerilo izgleda ovako 10:1 i prilikom ispisa na papiru crtež će biti uvećan 10 
puta.  

Dakle u LAYOUT-u se prebacite u MODELSPACE režim rada i sa padajućeg izbornika odaberite 
mjerilo.  
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Nadam se da sam uspio pojasniti kako se određuje mjerilo .  

DODATNI PRMJER: ( uvjet mjerilo i papir => dimenzije ? )  

Ako nam npr. netko da zadatak da nacrtamo određeni crtež u MJERILU ispisa 1:50 i dimenziju papira 
A4. Dakle ovdje su nam uvjetovani parametri Mjerila i veličine papira ( bez obzira koliko je predmet 
velik u stvarnosti )  

Krenimo redom:  

- Mjerilo je 1:50 
- Papir A4 ( 210 x 297 ) => koristan prostor => 184 x 285 ( morate voditi računa ako sastavnica 
ima tablicu pri dnu da i nju uračunate u koristan prostor tj. odbijete)  

Što moramo prvo uraditi ? 
Potrebno je odrediti stvarnu širinu i visinu objekta koji se može prikazati u korisnom prostoru.  
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Najveća širina objekta u stvarnosti može biti 920 cm a visina 1425 cm ( kada nacrtamo naš crtež i 
isprintamo )  

VELIČINA TEXTA na papiru ?  

Napomenuo sam da Mjerilo treba uvijek odrediti na samom početku crtanja. Zašto? 
Zato što moramo voditi računa o kotnim stilovima i njihovim veličinama teksta na crtežu i kotnim 
strelicama. Tako kada dobijete nekakv zadatak trebali bi dobiti i veličinu teksta koji će biti na 
isprintanom crtežu ( na papiru ). Obično se to kreće od 3-5 mm na papiru ali sve to ovisi o veličini 
papira ( A4, A3, A2... )  

Uzmimo za primjer da da imamo zadane parametre prije crtanja crteža: visina teksta mora biti 3 
mm na papiru a mjerilo je 1:10 
Kako odrediti veličinu teksta i kotnih završetaka da budu srazmjerni crtežu .  
Dakle kolika će biti vrijednost  ( jedinica ) za tekst itd...?  
I za to imamo formulu. 
 

   

 

Dakle, veličina teksta će nam biti 30 jedinica u Autocadu da bi na papiru to bila veličina 3 mm. 
Kako se rade postavke za tekst i kotne stilove pogledajte na linku 13 kompletnog autocad tutoriala 

I na kraju bi rezimirao sve gore navedeno vezano uz MJERILA.  

1. Postavite Format UNITS 
2. Prije samog početka crtanja crteža odredite si ( isplanirajte ) MJERILO u kojem ćete plotati crtež 
kao i veličinu papira. Na osnovu isplaniranog mjerila ovisit će količina prikazanog crteža na 
određenom formatu. ( npr: ako ste nešto isplanirali crtati u mjerilu 1:1000 a crtež je obiman po 
širini i "visini", isti nećete moći cijeli isprintati na format papira A4 u dotičnom mjerilu već samo dio 
crteža, ovakvi slučajevi se nađu u geodeziji prilikom izrade Kopije Katastarskog plana. ) 
3. Sve linije ( dužine ) crtajte u Autocadovim jedinicama bez obzira na mjerilo ( dakle dužina 10 u 
Autocadu jednaka je dužini 10 bilo da se radi o milimetrima, centimetrima ili metrima ) 
4. U odnosu na mjerilo postavite postavke za kotne stilove ( kreirajte svoj kotni stil ) a isto tako koje 
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veličine će Vam biti opisni tekst  
5. Kada nacrtate crtež tada prilikom Plotanja postavite mjerilo ( koje ste isplanirali ) i isprintajte 
crtež.  

Kako se rotira crtež u Layout modelu za ispis pogledajte na linkove ( na www.ic.ims.hr )  
24a. Rotiranje crteža i  
24b. Rotiranje crteža => ucsfollow 

  


